
 

 
 

ESG Utilities Wizards 3.2 User Guide 
for ER Mapper 6.4 with SP1 or higher 

Release 3.2 – May 2004 

This document is a user guide to running the “ESG Utilities Wizards” plug-ins (version 
3.2) for ER Mapper 6.4 or higher with Service Pack 1 or higher installed.  These wizards 
are developed, maintained and supported by Earthstar Geographics (ESG).  This 
document is organized into the following sections: 

• Overview of wizards and installation 

• New features in version 3.2 

• Workflows for processing multiple images in batch 

• Working with GeoTIFFs, and TIFF or JPEG images with “world” files 

• Details and tips on running each wizard 

• Troubleshooting 

Notes: This document is not intended as a user guide for the ER Mapper software.  You 
should be familiar with ER Mapper to gain full benefit from using these wizards.  Earth 
Resource Mapping does not provide support for these wizards, so you should read this 
document thoroughly and only then contact Earthstar Geographics if you have support 
questions. 

 

www.es-geo.com 

Note: This document covers version 3.2 of the ESG Utilities Wizards.  While some 
content is the same, it is not intended to be used as a reference for the previous releases 
of the wizards. 
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Wizard overview and installation 
 

 

The ESG Utilities Wizards for ER Mapper are designed as “power tools” to increase 
your productivity with ER Mapper.  You will find them useful for many purposes, 
including: 

• Batch operations, to let you run time consuming or tedious processes on many 
files unattended or overnight.  Batch wizards include image file imports, 
rectifications, orthorectifications, rotations, resampling, editing or creating 
header (ERS) files, printing, and exporting to various image formats. 

• Automated creation of useful products that would take much time and effort to 
create manually, such as cutting a large image or mosaic into tiles of uniform 
size, creating custom rotated clip regions,  and creating mosaic index maps. 

• Creating your ER Mapper color tables quickly and easily. 
• Creating your own “slideshows,” so you can easily display and cycle through a 

series of algorithms for demonstrations or presentations. 
• As template wizards that you can modify for your own purposes.  For example, 

you might modify the graphics import wizard to import additional file formats. 

Important:  The current release of the ESG Utilities Wizards 3.2 only runs on 
ER Mapper 6.4 or higher with Service Pack 1 (SP1) installed.  Older versions are 
available for ER Mapper 6.0-6.3 for PCs or ER Mapper 5.5a on Unix with reduced 
functionality.  (Contact us if you are interested.) 

System requirements 
To run these wizards, you must have a licensed copy of ER Mapper. 

ER Mapper version required: 6.4 or higher with Service Pack 1 installed 
Disk space required:  approx. 2 MB 

Important:  In addition to ER Mapper 6.4 or higher, you must have Service Pack 1 
(SP1) for 6.4 installed.  SP1 adds functionality required for several of the wizards, 
and they will not operate correctly without it. 

Using the wizards as templates 
The wizards are written in ER Mapper’s batch scripting language.  Users with some 
programming aptitude may want to use the wizards as templates to help create your 
own wizards that perform similar functions.  For this reason, the wizard script files 
contain detailed comments to help you understand their design and logic.   
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To modify a wizard, open the “.erb” file in a text editor and resave it under a 
different name.  (Be sure to do this immediately to avoid overwriting the original 
wizard.)  Then make your modifications and resave it.  You can run your new 
wizard by selecting View/Batch Engine Script Control, then clicking the Run 
Script button.  You can also create your own toolbar and run them from there.  See 
the ER Mapper documentation for details on creating batch scripts and wizards. 

Installing the wizards 
The ESG Utilities Wizards installation file is in ZIP format.  If you do not have 
software installed to read ZIP files, the WinZip software (www.winzip.com) will 
launch automatically in evaluation mode for you to unzip the file.  If you have other 
software to read zip files, you can use it instead to install the files into the main 
ER Mapper folder as described below. 

Important:  You must have the password supplied at the time of sale to run this 
installation procedure. 

1) Close all ER Mapper applications. 
2) Double-click on the “esgutwiz32.zip” install file icon in the Windows Explorer.  

The WinZip dialog displays.  (If you do not have WinZip installed, click “I 
Agree” on the WinZip evaluation dialog to continue.) 

3) Click the Extract button. Under 'folders/drives,' navigate to the directory 
location of ER Mapper on your system.  (This will typically be a directory named 
ERMAPPER64, ERMAPPER63 or similar.).  The 'Extract to' field should now 
show that location (i.e. C:\ERMAPPER64).  Be sure the "All files," "Overwrite 
existing files" and "Use folder names" options are selected  Then click the 
"Extract" button. 

4) Enter the password supplied to you, then click OK to extract the wizard install 
files into the appropriate ER Mapper directories. 

5) Close WinZip when finished. 
6) Restart ER Mapper, then select ESG Utilities from the Toolbars menu to display 

the Utilities wizards toolbar. 

Note:  The installation only adds new files, it does not replace any files that ship 
standard with ER Mapper.  (Any custom ER Mapper files you have added are also 
not disturbed.) 
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Accessing the wizards within ER Mapper 
The wizards are setup as a “toolbar” inside ER Mapper.  To gain access to them, 
select ESG Utilities from the Toolbars menu on the main ER Mapper menu bar. 

 

The ESG Utilities toolbar is setup with thirteen buttons; each starts up a wizard.  If 
you point the mouse to a button, the name of the wizard appears next to it (the “tool 
tip”).  Wizards are referred to by these names in the rest of this document. 

Files added during installation 
The ESG Utilities wizards installation procedure adds the following files to your 
ER Mapper 6.3 installation. 

Installed into ERMAPPERXX/batch (executable wizard code): 
ESG_Create_Index_Map.erb 
ESG_Rotate_Resample_Batch.erb 
ESG_Reproject_Batch.erb 
ESG_Rectify_Batch.erb 
ESG_Orthorectify_Batch.erb 
ESG_Print_PC_Batch.erb 
ESG_Edit_ERS_Batch.erb 
ESG_Import_Images_Batch.erb 
ESG_Export_Images_Batch.erb 
ESG_Cut_Alg_Tiles.erb 
ESG_Create_Rotated_Clip_Regions.erb 
ESG_Color_Table_Wizard.erb 
ESG_Slideshow_Wizard.erb 

Installed into ERMAPPERXX/batch/lib (executable wizard code): 
ESG_Get_Proj_Units.erb 

Installed into ERMAPPERXX/config (main menu toolbar file): 
ESG_Utilities.bar 
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Installed into ERMAPPERXX/icons (toolbar button images): 
esg-uttb1.tif 
esg-uttb2.tif 
esg-uttb3.tif 
esg-uttb4.tif 
esg-uttb5.tif 
esg-uttb6.tif 
esg-uttb7.tif 
esg-uttb8.tif 
esg-uttb9.tif 
esg-uttb10.tif 
esg-uttb11.tif 
esg-uttb12.tif 
esg-uttb13.tif 

Installed into ERMAPPERXX/icons/Standard_icons/Wizards (wizard images): 
esg-utidx.tif 
esg-uttfw.tif 
esg-utshow.tif 
esg-utrprj.tif 
esg-utrect.tif 
esg-utpcb.tif 
esg-utimpg.tif 
esg-utrot.tif 
esg-uteders.tif 
esg-utetab.tif 
esg-utetfw.tif 
esg-utclip.tif 
esg-utegtf.tif 
esg-utort.tif 
esg-utlut.tif 
esg-uttile.tif 

Uninstalling the wizard files 
There is no “uninstall” utility.  You can manually delete all the files listed above to 
accomplish this if desired.  (As indicated, most files start with the letters “ESG” or 
“esg.”)  However, they take up very little disk space (approx. 2 MB) and will not 
impact other software products. 
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Possible limitations on file size and performance 
The same limitations inherent in processing imagery through ER Mapper’s GUI also 
pertain to processing through the wizards.  Increasing the amount of memory (RAM) 
on your computer will help processing speed as well. 

How to tell your wizard version 
To determine which version of the ESG Utilities Wizards you have installed, click the 
‘Help’ button on the first page of any wizard.  The latest version is 3.2, and that is the 
version described in this document.  If are running an earlier version, please contact 
Earthstar Geographics for an upgrade. 

Enhancements/changes in version 3.2 (April 2004) 
Version 3.2 of the wizards were tested with ER  Mapper version 6.4 with Service 
Pack 1 installed.   Some of the wizards will not function properly with ER Mapper 
6.4 if Service Pack 1 is not installed.  The following enhancements and changes have 
been made to the ESG Utilities Wizards for this version 3.2 release (see the specific 
section on each wizard for details).  Many of these are designed to take advantage to 
new features in ER  Mapper 6.4 such as geocoding of multiple file formats and 
reprojection of large files: 

• All geocoding-related wizards (rectify, orthorectify, rotate/resample and 
reproject) can now read any raster format supported by File->Open and write to 
ER Mapper Raster (.ers), TIFF/GeoTIFF (.tif) and ECW (.ecw) image formats.  
This means you can batch reproject GeoTIFFs to GeoTIFFs or ECWs (or other 
combinations) without creating intermediate ER Mapper Raster files as was 
necessary before 6.4. 

• “Reproject Images in Batch” can now process very large input files (several GB), 
so cutting large images into pieces in order to reproject them is no longer 
necessary.   

• All geocoding-related wizards can now be run in a background mode via a DOS 
batch (.bat) file.  This lets you continue to use ER Mapper normally while the 
operations are running in the background.  (Before you had to let the wizard 
finish before resuming normal use of ER Mapper.) 

• All wizards with background mode run options via a DOS batch (.bat) file now 
do not automatically start the batch process.  This lets you run the process at any 
time you want by launching the BAT file (double-click on it) or using the 
Windows Scheduled Tasks function to start it at a specific time. 

• “Cut Algorithm into Tiles” now has an option to cut tiles using a text file 
containing the tile names and extents.  This helps when tiling irregular areas or 
when specific filenames are required. 
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• “Import Images in Batch” now imports USGS DEM (both .dem and .cdo 
extensions), ERDAS IMAGINE, ERDAS LAN,  and PCI PIX formats. 

• All wizards that export to the ECW format (all geocoding-related, Export 
Images, and Cut Algorithm Tiles) now allow resampling (changing the 
resolution/cell size) while exporting to the ECW format. 

•  “Export Images in Batch” and “Cut Algorithm into Tiles” now handle mosaic 
algorithms that are reprojected on-the-fly.  This means that exported images can 
be output in a different projection than the source input images. 

• “Cut Algorithm into Tiles” can now create up to 99,999 tiles in one batch run.   
• “Cut Algorithm into Tiles” has better documentation here on how to create “butt 

joined” tiles with no overlap.   
• “Create Mosaic Index Map” and “Export Images in Batch” (export from mosaic 

option) now handle mosaic algorithms that contain multiple surfaces.   
• “Create Mosaic Index Map” now writes the index boxes as polygons (instead of 

rectangles), so they can be reprojected if needed.   
• The ability to add comments to World files (formerly in Export Images and Cut 

Algorithm Tiles) has been removed since they did not work with the output via 
DOS BAT file method. 

Enhancements/changes in version 3.1 (January 2003) 
Version 3.1 of the wizards were tested with ER Mapper version 6.3 with Service Pack 
1 installed.  Some of the wizards will not function properly with ER Mapper 6.3 if 
Service Pack 1 is not installed.  The following enhancements and changes have been 
made to the ESG Utilities Wizards for this version 3.1 release (see the specific section 
on each wizard for details): 

• A new “Create Rotated Clip Regions” wizard has been added to let you create 
clip regions for a set of images in batch that mask out a percentage of the image 
area, and can be rotated for better results with oblique image mosaics.   

• All wizards now handle creating files in directories that contains periods in the 
directory name (e.g., “C:\Images_12.5m\”).   

• “Import Images in Batch” now reads rotation terms from World files for input 
TIFF and JPEG images and transfers them to imported ERS images. 

• “Edit or Create ERS File in Batch” now reads rotation terms from World files and 
transfers them to generated ERS header files.   

• “Export Images in Batch” now reads rotation terms from input image files and 
transfers to World files accompanying TIFF or JPEG output. 

• The “Export Images in Batch” and “Cut Algorithm into Image Tiles” wizards 
now have an option to run the batch process outside ER Mapper via a DOS batch 
file, instead of a looping ER Mapper script.  This option has some limitations, but 
allows other ER Mapper wizards to be run while the batch process is running. 

• “Create Color Tables” wizard is now fixed (was not working in 3.0) 
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General multi-image workflows 
 

 

This section describes general workflows you might follow to streamline processing 
of multiple images.  These procedures generally pertain to mosaicking airphotos or 
similar images, but may be useful for other types of data as well.  They reference the 
use of these ESG Utilities Wizards as well as some wizards that come with 
ER Mapper (such as the “Image Display and Mosaic Wizard” and the “Balancing 
Wizard”). 

Running batch processes with BAT files or scripts 
Many of the wizards give you the options of running the final batch process “in the 
background” or “via an ER Mapper script.”   Running in the background is usually 
recommended for most jobs.  Here are the differences: 

• Running in the background–With this option, the wizard creates a DOS batch 
(.BAT) file that contains all the program commands to run in the batch process.  
This file can then be run by double-clicking on it in Windows Explorer or via the 
Windows Scheduled Tasks function to run it at a scheduled time in the future.  
The other main advantage to this method is that you can continue to run 
ER Mapper normally while the process runs in the background.   While the BAT 
file is running, a command window is displayed on-screen showing the progress 
and current command being run.  Note that ER Mapper error messages 
encountered during processing cannot be displayed when running via BAT file, 
so make sure your input images are properly set up.  

• Running via an ER Mapper script–With this option, the wizard runs the batch 
procedure immediately using a looping ER Mapper script.  This does give you 
more on-screen messages, records error messages, and displays a progress bar 
that you will not see using the run in the background method.  However, some 
important ER Mapper functions may not be available until the script has 
completed (such as File->Open), so you have limited options to use ER Mapper 
until it completes.  This method is therefore useful for smaller jobs of if you don’t 
plan to use ER Mapper while it’s running. 

Launching a BAT file 
immediately 

To launch a BAT file created by a wizard immediately, simply double-
click on the file’s icon in Windows Explorer. 
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Using Windows 
Scheduled Tasks 

To use Windows Scheduled Tasks to run a BAT file created with a wizard: 

1) Open the Control Panel and double-click Scheduled Tasks. 
2) Double-click Add Scheduled Task. 
3) On the Scheduled Task Wizard, click Next>. 
4) Click the Browse button, then select  the .bat file created by the wizard.  (All 

wizards tell you this file’s location, most in a log file in the output directory.) 
5) Click One time only, then click Next>. 
6) Select the time and date to run the BAT file, Next>. 
7) Enter the user and password, Next>.  (Note: The script may not run unless you 

enter the user name and password.) 
8) Click Finish.  The task is added to the list and runs at the scheduled time with 

status/error messages shown in a command window. 

Importing Files vs. Creating ERS Headers 
If you have TIFF file with World (.tfw) or JPEG with World (.jgw, .jpw or .jpegw) 
files, you have two options for using the ESG Utilities to allow display and 
processing in ER Mapper.  Use the following guidelines to determine when you need 
to import them, or when you can simply create ERS headers: 

• Creating ERS header files–Use this procedure when you want to simply 
display, mosaic, or color balance the existing image files.  In this case, there is no 
need to import each file to create a second copy of the data.  You simply need to 
create an ERS header file for each TIFF or JPEG image so ER Mapper can display 
them with the proper georeferencing information.  Use ESG’s “Edit or Create 
ERS Files in Batch” wizard to do this.  (See the following section “Mosaicking 
and Balancing Images with World or TAB Files” for more information.) 

• Importing files–Importing used to be necessary in ER Mapper 6.3 or earlier 
because geocoding operations could not be performed directly on files in TIFF, 
JPEG, ECW, etc. image formats.  With 6.4, ER Mapper now reads these formats 
directly for geocoding operations.  However,  importing can still be useful for 
Targa, USGS DEM, ERDAS LAN and other formats that ER Mapper does not 
read directly.  To run batch imports, use ESG’s “Import Image Files in Batch.” 
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Mosaicking and Balancing Images with World or TAB Files 
If you want to simply mosaic and/or color balance TIFF, JPEG or BMP images with 
World or TAB files, you can use the images directly within ER Mapper without 
having to first import them to ER Mapper format.  This typically involves creating 
ER Mapper header (ERS) files for each TIFF or JPEG that contains the correct 
georeferencing information.  ESG’s “Edit or Create ERS Files in Batch” wizard lets 
you create ER Mapper ERS headers for the following data types: 

• TIFF (.tif), JPEG (.jpg) or BMP (.bmp) images with MapInfo table (.tab) files 
• TIFF (.tif) with World (.tfw) files 
• JPEG (.jpg) with World (.jgw, .jpw or .jpegw) files 
• Windows Bitmap (BMP) with World (.bpw) files 

To do this, use ESG’s “Edit or Create ERS Files in Batch” wizard to create ER Mapper 
header (ERS) files for each TIFF, JPEG or BMP in the directory.  You will need to 
know the correct ER Mapper datum and map projection of your TIFF, JPEG or BMP 
images because this information is not contained in World files, and cannot be 
interpreted by the wizard from TAB files. 

After doing this, you can mosaic, color balance, compress and otherwise process the 
images directly in ER Mapper as desired.  (Be sure to open or mosaic the ERS files, 
not the .tif, .jpg or .bmp files.) 

Note: If your TIFF, JPEG or BMP files do not have corresponding World or TAB files, 
you cannot mosaic them because these files contain the georeferencing information.  
The exception are GeoTIFF files, which can be displayed and processed directly in 
ER Mapper because the georeferencing information is embedded in the TIFF file 
itself.  

Geocoding “raw” Image Files 
In some cases you may have “raw” image (TIFF, JPEG, BMP, etc.) files such as 
airphotos or scanned maps, and you want to use ER Mapper to geocode them.  
ER Mapper 6.4 can now perform geocoding operations directly on graphics formats 
such as TIFF, JPEG, and BMP.  Here is the procedure: 

1. Use ER Mapper’s “Geocoding Wizard” to define ground control points (GCPs) or 
define orthorectification information for each image, but do not perform the final 
“Rectify” step in the “Geocoding Wizard.”  (I.e., hit the “Save” button, not “Save 
File and Start Rectification,” then exit.)  It is recommended that all your images to 
be geocoded be placed in the same directory because this will make it easier to 
batch process them in the next step. 

2. Use ESG’s “Rectify Images in Batch” wizard to rectify all the images for which 
you selected GCPs in step 2.  Or, if you defined orthorectification parameters for 
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the images, use ESG’s “Orthorectify Images in Batch” wizard to orthorectify all 
the images. 

3. If desired, use ER Mapper’s “Image Display and Mosaic Wizard” to mosaic all the 
output rectified or orthorectified images. 

4. If desired, use “ESG’s Export Images in Batch” wizard to export each rectified 
image to any of several export formats.   

5. If desired, use ESG’s “Create Mosaic Index Map” wizard to create an index map 
of each rectified image in a mosaic.  (First use ER Mapper’s “Image Display and 
Mosaic Wizard” to mosaic the rectified images, then use that algorithm as input 
to ESG’s “Create Mosaic Index Map” wizard.) 

Options for exporting TIFF Images 
ER Mapper provides great flexibility for exporting TIFF images in many different 
variations.  The “ESG’s Export Images in Batch” and “Cut Algorithm into Image 
Tiles” wizards provide all these options.  You need to select the options that pertain 
to the way you want the images exported, and the products that will used to read 
them later.  Use the following guidelines to determine how to select TIFF export 
options. 

Note: The goecoding-related wizards use a different program to create TIFFs that 
don’t allow selection of the options below.  They generally export the TIFF in with 
characteristics matching the input images. 

TIFF Output Type Output types refer to the color depth or number of bands in the output TIFF 
image: 

• RGB (truecolor)–Saves the TIFF image as a 3-band file with Red, Green and Blue 
layers (channels).  RGB should normally always be used when saving color 
images such as airphotos or satellite images to retain the full range of colors. 

• Greyscale–Saves the TIFF image as a 1-band greyscale image.  Greyscale should 
normally always be used when saving black and white (greyscale) images such 
as airphotos or panchromatic satellite images.  If the input image is color, 
selecting Greyscale will cause the color image to be transformed to a greyscale 
representation (basically image brightness) in the output image. 

• 256 Color–Saves the TIFF image a 1-band file with a color palette containing up 
to 256 colors.  This option is useful for saving images with few colors, such as 
scanned topo maps or classifications because it creates a color image file 1/3 the 
size of an RGB image.  In addition, LZW compression is especially effective on 
these types of images.  This option should normally not be used to export color 
images such as airphotos because the number of colors (often millions) will be 
thinned to 256 during export which can cause great loss of color resolution.   
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• Multi Layer–Designed to save the TIFF image as a 1-,  3- or 4-band file with 
options for 8-bit or 16-bit data types.  Typically this would be used to export raw 
data values to the TIFF, rather than a contrast enhanced image.  For example, the 
original values of a 16-bit DEM could be saved to TIFF format by selecting Multi 
Layer, Signed 16-bit data format, and Delete output transforms options. 

TIFF Data Type When the Multi Layer output type is selected, you have options for a data type.  
The Data Type options only apply if Multi Layer is selected (RGB, greyscale and 
256-color images are always output as unsigned 8-bit data type). 

The different data type options are designed to encode a specific value range in the 
output TIFF.  Here are some examples to use as guidelines: 

• Exporting DEM data–DEMs can have data ranges from zero (or negative) to 
several thousand.  If your DEM had ranges between 0 and 2000, you could save 
it to an Unsigned 16-bit data type to retain those values in the output TIFF.  If 
your DEM included negative elevations, you would need to save as Signed 
16-bit so both positive and negative values would be retained.  In this case, you 
should almost always select “Delete output transforms” option, otherwise the 
original values will be rescaled to 0-255 no matter what data type you select. 

 If all values in your DEM were less than 255, then you could safely save it as 
8-bit.  If your DEM values were floating point (i.e., 250.345), then they will be 
rounded to the nearest integer value (250) in the output TIFF. 

• Exporting 11-bit data–IKONOS, Quickbird and some other high resolution 
images store values in 11-bit format, and several other satellite image types 
contain values up to 16-bit format.  To export these original values to a TIFF file 
(for example to crop or subset a small area from a larger image), you need to 
select the Multi Layer format with Unsigned 16-bit data type and select “Delete 
output transforms.” If you want to export a contrast stretched version as a 
“final” image, then save as RGB or greyscale without deleting transforms. 

• Consolidating separate images–In some cases, you might have separate image 
files that you want to consolidate into a single 3- or 4-band image.  (For example, 
images that are shipped as one file per band, or 3 different co-registered dates 
covering the same area.)  Create an algorithm with a layer for each image (4 
layers maximum), then save it as a Multi Layer with the appropriate data type 
and transform deleted.  The same thing could be done to subset 3 or 4 bands of a 
Landsat image into one 3- or 4-band TIFF file. 

Note: Many applications will not properly read 16-bit TIFFs or TIFFs that contain 4 
bands of data.  Most remote sensing products will read these files, but you should 
check that your application can read them before creating them in batch. 
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Deleting transforms 
for TIFF images 

Whether to select the “Delete output transforms” option depends on 
whether you want to export images with or without the contrast 
enhancements you’ve made to the screen.  ER Mapper’s Transform (the 
histogram tool) is designed to let you transform raw image values into a 
nice picture on the screen. 

• To output the exact image you see on the screen (in the image window), always 
turn off the “Delete output transforms” option.  (This will also cause the output 
image data range to be 0-255.) 

• To output the raw images values in the input image to the output TIFF file, 
always turn on the “Delete output transforms” option.  (This throws away any 
contrast enhancements in the input algorithms.) 
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Running the wizards 
 

This section describes basics on running each wizard and details on features and 
capabilities.  It also lists special tips for getting the most from the wizards, as well as 
limitations and things to be aware of before running them.  You will achieve best 
results if you read these sections before running the wizards. 

Note: For general tips and troubleshooting, see the section “Troubleshooting” 
following this.  Please be sure you consult the troubleshooting section before reporting 
problems. 

 Import Image Files in Batch 
 

This wizard lets you import TIFF, GeoTIFF, DOQQ, ECW, BMP, JPEG, GIF, Targa, 
PCX, USGS DEM, ERDAS IMAGINE and LAN, and PCI PIX image files to 
ER Mapper Raster Image (.ers) format in batch.  This can be handy when you have 
multiple files to import and don’t want to import them one at a time through the 
standard interface.   Output ER Mapper images are given the same name as the input 
file (e.g., ‘image1.tif’ imports to files ‘image1’ and ‘image1.ers’). 

ER Mapper 6.4’s ability to perform geocoding operations on all supported formats 
has removed many reasons you had to import files in the earlier versions.   Batch 
importing can still be useful to convert raster formats that are not supported directly 
(USGS DEM, IMG, PIX, etc) and for using the Traverse feature that only supports ER 
Mapper Raster format.  You can also batch uncompress ECW files.   Options include: 

• Import up to seven files from various locations, all files in a directory, or all files 
listed in a text file. 

• Import TIFF or JPEG with “World” files, and encode the coordinates, datum, 
projection and units in the ER Mapper files. 

• Import ECW compressed image files to uncompress them into ER Mapper Raster 
image format. 

• Import 11-bit and 16-bit GeoTIFF files (IKONOS, Quickbird and others).  
• Automatically calculate multivariate and/or balancing statistics for each image 

after import. 
• Pop-up status dialog to indicate progress of the imports, including current file 

and percent complete bar showing progress of the batch operation. 
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Why import image 
formats that 

ER Mapper can read 
directly? 

This wizard is an alternative to opening each image one at a time and then 
saving as an ER Mapper Raster image.  ER Mapper can directly read some 
image formats such as TIFF and JPEG, but does not create an ER Mapper-
format data file when it does this.  While this is a nice feature, you still 
need ER Mapper-format images to use the Traverse function or perform 
certain other operations.  Also, very large TIFFs (especially 11-bit or 16-bit 
tiled images) can take quite a bit of time to load when direct opening them 
using the raster translators.  Therefore, you might use this utility when 
you want to create ER Mapper-format images from your images (which 
open more efficiently)  as a batch process for multiple files.  

Importing TIFF or 
JPEG with World files 

The wizard includes filetype options for importing TIFF or JPEG with 
World files.  The world files contain the upper-left corner coordinate, 
rotation, and cell size of the image, and this information is automatically 
transferred to the imported ER Mapper image.  If a world file is not 
present in the same directory, the TIFF or JPEG is imported but the 
imported image contains no georeferencing information.  (The wizard 
notifies you if this occurs in status messages and in the log file). 

In addition, the wizard prompts for the datum and map projection of the 
TIFF or JPEG images because this not included with the world file. This 
lets you import a large list of TIFF or JPEG with World files and have all 
the correct georeferencing information entered into the ER Mapper 
images.  

If your input TIFF or JPEG World files contains rotation parameters, these 
are transferred to the ER Mapper image header (ERS) files automatically.  
(The ERS header will have a single rotation value and the cell sizes may be 
different than listed in the World files.  This is normal.) 

TIFF or JPEG with 
World images in foot-

based projections 

If you select an ER Mapper projection with units of feet (such as US State 
Plane), the wizard will automatically convert the cell sizes from the World 
files (in feet) to their meter-equivalent values in the ERS headers of the 
imported files.  (The wizard informs you of this before proceeding.)  This 
is needed because ER Mapper must have cell sizes expressed internally in 
meters, even for projections whose XY units are feet. 

Importing a directory 
of USGS DOQQ 

images 

USGS DOQQ (Digital Ortho Quarter Quad) images can have several 
different file extensions.  If you are using the “Import all files in a 
directory” option, the wizard must assume that all files in the input 
directory are DOQQs.  Therefore, be sure that the input files directory 
contains only DOQQ images (no other files or subdirectories).  If other files 
or subdirectories are present, you will receive error messages about these 
but the wizard should continue on to import all valid DOQQ files. 

Note: Sometimes DOQQs are provided in other formats such as GeoTIFF 
or TIFF with World.  Use the appropriate import option for these (not the 
DOQQ option). 
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Importing USGS DEM, 
ERDAS and PCI 

formats 

The import programs for USGS DEM, ERDAS IMAGINE and LAN and 
PCI PIX support most, but not all variants of the formats.  Therefore some 
files may not import correctly.  You can try a test by using the Utilities-
>Import Image Formats options in ER Mapper.  If the file imports there, it 
will import correctly using the wizard. 

Importing from a text 
file list 

You can specify the files to be imported by creating a text file listing the 
full path and filename of each file.  This allows the input files to be stored 
in different areas on your system.  An example text file might look like 
this: 

D:\Images_NW\image01.tif 
D:\Images_NW\image02.tif 
C:\Images_SW\image03.tif 
C:\Images_SW\image04.tif 

No other information or lines can be in the text file, only full path 
filenames (each line separated by a carriage return).  Input filenames 
should be unique because the output files will be written to a single 
directory.  The wizard will parse your text file and warn you if it can’t 
understand the format, or if some of the listed images don’t exist. 

Supported file 
extensions 

The wizard only looks for files with the 3-character file extension listed in 
the “File type to import” list.  (Files with other extensions, for example 
“image1.tiff” or “photo.jpeg” will not be recognized.)  The exception to 
this rule is USGS DOQQ images that can have many different file 
extensions (so the wizard allows any extension). 

GeoTIFF datum and 
projection 

When importing GeoTIFF files, the datum, projection and other 
georeferencing information are encoded automatically in the output 
ER Mapper image during the import.  If the projection in the GeoTIFF file 
has no direct match in ER Mapper’s projection database, some 
georeferencing information cannot be set automatically.  This wizard uses 
the latest version of the ER Mapper GeoTIFF library. 

GeoTIFF files with 
World TFW files 

Sometimes vendors will supply images in GeoTIFF format, but also 
supply an accompanying World (.tfw) file for software that cannot 
interpret the GeoTIFF information.  If you know the images are in 
GeoTIFF format, you should always select the filetype “TIFF or GeoTIFF 
(.tif),” not the “TIFF (.tif) with World” type.  Only use “TIFF (.tif) with 
World” for plain TIFF images with World files.  

Note:  To determine if your TIFF files are in GeoTIFF format, select File-
>Open, click once on the desired TIFF file, then click Info.  If you see a 
projection of “RAW” or “LOCAL” then the image is not a GeoTIFF.  (You 
may see a valid datum and projection if an ERS header file has been 
created for the TIFF.  If this is the case, make a copy of the TIFF in a 
separate directory without the ERS, then perform the above test on it to 
determine whether it is a GeoTIFF or plain TIFF.) 
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 Rectify Images in Batch 
 

This wizard lets you rectify all images in a directory in batch.  Since rectification of 
large files can take quite a bit of processing time, this lets you take advantage of 
overnight batch processing.  You must first have selected and saved ground control 
points (GCPs) for each image using ER Mapper’s Geocoding Wizard.  Options 
include: 

• Polynomial or Triangulated rectifications. 
• Input images can be in any format supported by ER Mapper (those listed on 

File->Open->All Supported Files). 
• Use output cell size and null value parameters pre-defined for each image (using 

ER Mapper’s Geocoding Wizard), or override them by specifying a common 
output cell size and null value applied to all rectifications. 

• Output to ER Mapper Raster (.ers), TIFF/GeoTIFF (.tif) or ECW compressed 
(.ecw) image formats.  

• Append a text string to output filenames to differentiate them from input files of 
the same name, for example “geocoded.”  (Otherwise, output files get the same 
name as input files in which case they must be written to a different directory.) 

• Output via an ER Mapper script, or a DOS BAT file that can be run now or at a 
later time. 

Note: The wizard cannot predict the amount of disk space required to store your 
output rectified files, so you must make sure the output directory has sufficient 
space before running the wizard. 

Output filenames This wizard always creates it’s own output filenames, and cannot use 
output filenames pre-defined for images using the Geocoding Wizard.  
You may choose to have the output filenames be the same as the input 
filenames (for saving to a different directory), or you may append the 
input filenames with a text string (which allows saving to the same 
directory as the input files). 
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Rectification 
parameters that can 

be overridden 

As noted, you must select GCPs for each image beforehand using 
ER Mapper’s Geocoding Wizard.  However, some information cannot be 
read from the ER Mapper files by this wizard during batch rectification 
and some can as follows: 

• The output filename, polynomial order (for polynomial rectifications), and 
rectify background areas setting (for Triangulation rectifications) cannot be read 
from the input images so must be specified in this wizard.  (The wizard creates 
its own output filenames as described later.) 

• Output cell size, null value and resampling method can be read and 
used to rectify each input file (by selecting the ‘Use rect. parameters 
stored in each image’ option), or can be overridden in this wizard to 
use a common set for rectification of all images (by selecting the ‘Enter 
common parms used for all images’ option). 

Rectifications to the 
GEODETIC projection 

When rectifying images to the GEODETIC projection, only use the ‘Use 
rect. parameters stored in each image’ option in this wizard.  Do not use 
the ‘Enter common parms used for all images’ option because cell sizes (in 
degrees) entered in the wizard cannot be recognized correctly (and output 
files will be highly subsampled). 

Output cell sizes When using the ‘Enter common parms used for all images’ option, be sure 
to select an output cell size that makes sense for your images.  The default 
value of 1 is only appropriate for very high resolution images such as 
airphotos.  You should determine the desired output cell size before 
running the wizard.  Unreasonable cell sizes will produce overly large 
output files if the cell size is too small, or cause loss of image detail if the 
cell size is too large.  As in the ER Mapper GUI, the output cell size must 
always be expressed in meters, even if you are rectifying to a foot-based 
map projection such as U.S. State Plane. 

Polynomial order and 
number of GCPs 

Each image to be rectified must have sufficient GCPs selected for the type 
of rectification you select.  If you select a polynomial order of Quadratic, 
for example, each image must have at least six GCPs selected.  The wizard 
will attempt to skip images with insufficient GCPs and rectify the others, 
but you should verify this ahead of time.  System messages will be 
displayed on screen and written to the log file if this occurs. 
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 Reproject Images in Batch 
 

This wizard lets you reproject (map-to-map transform) or datum shift all images in a 
directory in batch.  Since reprojection of large files can take quite a bit of processing 
time, this lets you take advantage of overnight batch processing.  Options include: 

• Input images can be in any format supported by ER Mapper (those listed on 
File->Open->All Supported Files). 

• Output to ER Mapper Raster (.ers), TIFF/GeoTIFF (.tif) or ECW compressed 
(.ecw) image formats.  

• Resampling type, speed optimization and null cell value setting. 
• Images with different input cell sizes can retain the same cell sizes when output, 

or can be resampled to a single common cell size for all output images. 
• Append a text string to output filenames to differentiate them from input files of 

the same name, for example “UTM23.”  (Otherwise, output files get the same 
name as input files in which case they must be written to a different directory.) 

• Output via an ER Mapper script, or a DOS BAT file that can be run now or at a 
later time. 

Note:  This wizard cannot predict the amount of disk space required to store your 
output reprojected files, so make sure the output directory has sufficient space 
beforehand. 

Understand the 
projections you are 

using 

When reprojecting images, it is important to understand the parameters of 
the “from” and “to” projections you are using.  Choosing an inappropriate 
output projection for your input data can cause errors.  For example, you 
would not want to reproject an image that covers an entire continent to a 
UTM projection that is designed only for areas up to 6 degrees wide.  It is 
a good idea to test the reprojection of one of your images in the Geocoding 
Wizard to make sure the results are appropriate before using this wizard 
to batch process all of them. 

Datum shift 
parameters must be 

defined 

When using this wizard to shift datums (for example NAD27 to NAD83), 
be sure that the datum shift you want to perform has been defined in 
ER Mapper’s database.  (ER Mapper supports many datums, but does not 
have predefined shift parameters between all combinations of them.)  If a 
datum change has not been defined, you may get an error such as 
“Geodetic transform error: S2:(trn_init)" when attempting 
to perform the reprojections.  See the ER Mapper documentation for 
instructions on defining datums changes.  It is a good idea to test the 
datum shift of one of your images in the Geocoding Wizard to make the 
shift is supported before using this wizard to batch process them. 
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Output filenames This wizard always creates it’s own output filenames.  You may choose to 
have the output filenames be the same as the input filenames (for saving to 
a different directory), or you may append the input filenames with a text 
string (which allows saving to the same directory as the input files). 

Output cell sizes You can resample (change the cell size) or all output reprojected images if 
desired.  This can be useful, for example, if all your input images have 
slightly different cell sizes (0.98m, 1.02m, etc.) and you want to resample 
them all to a common size (1.0m).   

If you do not select to resample to a common cell size, the wizard will 
assign each output image the same cell size as the corresponding input 
image.  When doing this, you have an option to force the X and Y output 
cell sizes to be the same value (whichever is smaller).  Using this option 
will result in larger output files.  Not using the ‘Make output X and Y sell 
size equal’ option will optimize the output file sizes, but you may get 
images with different X and Y cell sizes (especially if reprojecting to or 
from the GEODETIC projection). 

When reprojecting from any meter-based projection (UTM, etc) or 
foot-based projection (U.S. State Plane, etc.) to the GEODETIC projection, 
the image cell sizes will be converted to their equivalent values in decimal 
degrees.  When doing the opposite, cell sizes will be converted to from 
degrees to meters.   

Output null cell 
values 

When reprojecting images, the output images are typically stretched 
and/or rotated slightly by the transformation.  Any “empty” areas created 
on the edges where no real image data exists should normally be filled 
with a “null cell value” when running the wizard.  This allows these 
empty areas to be ignored when mosaicking the output images to create a 
seamless mosaic.  (For typical satellite images or airphotos, the null value 
would usually be set to zero.  If using the ‘Use parms defined with 
Geocoding Wizard’ option, the null value is defined with the Geocoding 
Wizard.) 

If you do not set a null cell value (do not check the ‘Use null value below’ 
checkbox), the output images will not have a null value.  This means all 
data is considered valid data and will be displayed as such.  So, empty 
edge areas may overlap with areas of real data when a mosaic is created, 
which may not be desirable.   
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 Rotate or Resample Images in Batch 
 

This wizard lets you rotate or resample (change the pixel size) of all images in a 
directory in batch.  Since rotation and resampling of large files can take quite a bit of 
processing time, this lets you take advantage of unattended batch processing.  You 
might use this to rotate scanned images 90 degrees to aid geocoding, rotate images to 
point north, resample images to reduce the resolution or set all to a common 
resolution, and so on. Features include: 

• Input images can be in any format supported by ER Mapper (those listed on 
File->Open->All Supported Files). 

• Output to ER Mapper Raster (.ers), TIFF/GeoTIFF (.tif) or ECW compressed 
(.ecw) image formats.  

• Select to rotate all images by a fixed amount, rotate all to the same orientation, or 
resample the pixel size only. 

• For rotation by fixed amount, select the amount and clockwise or counter-
clockwise rotation. 

• Automatically rotate all images to point to the same orientation (for example 
north) regardless of the current orientation of each image. 

• Resample to a different cell size while rotating if desired. 
• Append a text string to output filenames to differentiate them from input files, 

for example "north" or "50m." 
• Output via an ER Mapper script, or a DOS BAT file that can be run now or at a 

later time. 

Note: The wizard cannot predict the amount of disk space required to store your 
output rotated or resampled files, so you must make sure the output directory has 
sufficient space before running the wizard. 

Output filenames This wizard always creates it’s own output filenames.  You may choose to 
have the output filenames be the same as the input filenames (for saving to 
a different directory), or you may append the input filenames with a text 
string (which allows saving to the same directory as the input files). 

Batch rotations Batch rotations can be helpful, for example, for rotating a series of scanned 
images or maps 90 degrees to orient them with other images, or make it 
easier to pick GCPs while geocoding.  Batch rotations are also useful for 
seismic or geophysical images that were rotated by ER Mapper during the 
import process.  Rotating them all north or to a common orientation lets 
you “undo” the rotation ER Mapper applied, so the images have the same 
orientation as in the software from which they were imported. 
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Rotations to a 
common orientation 

Batch rotations to a common orientation (i.e., north) can only be performed 
correctly if each input ER Mapper image has the correct orientation in the 
header (ERS) file.  For example, if you have a group of “RAW” files whose 
true orientation is not known, the wizard will look at the current rotation 
value (usually 0.0) and rotate them accordingly to achieve the desired 
output rotation value.  However the output files orientation is not 
necessarily north or east, etc. since the true input rotation was not known. 

Batch resampling Batch resampling can be useful in cases where you wish to decrease the 
amount of image detail to reduce file sizes, or if you need to resample 
images with different X and Y sizes to one common size.  For example, 
you have a series of 1-meter resolution airphotos, but your client or 
colleague only needs 3-meter resolution.  By resampling to three meters, 
you decrease the file size of each image by a factor of nine.  (You can also 
use ER Mapper’s ECW compression option to decrease file sizes while 
maintaining the full image detail.) 

 Orthorectify Images in Batch 
 

This wizard lets you orthorectify all airphoto images in a directory in batch.  Since 
rectification of airphotos can take quite a bit of processing time, this lets you take 
advantage of overnight batch processing.  You must first have selected and setup the 
orthorectification parameters for each image using ER Mapper’s Geocoding Wizard 
(but do not perform the final “Rectify” step).  Output orthorectified files may be 
given the same filename as their corresponding input file, or may have a text string 
added to differentiate them.  Options include: 

• Input images can be in any format supported by ER Mapper (those listed on 
File->Open->All Supported Files). 

• Output to ER Mapper Raster (.ers), TIFF/GeoTIFF (.tif) or ECW compressed 
(.ecw) image formats.  

• Orthorectification using GCPs or Exterior Orientation. 
• Use the ortho parameters already defined for each input image, or specify 

different output resampling, cell size and/or null value to be used for all images. 
• Append a text string to output filenames to differentiate them from input files of 

the same name, for example “ortho.”  (Otherwise, output files get the same name 
as input files in which case they must be written to a different directory.) 

• Output via an ER Mapper script, or a DOS BAT file that can be run now or at a 
later time. 

Note: The wizard cannot predict the amount of disk space required to store your 
output orthorectified files, so you must make sure the output directory has sufficient 
space before running the wizard. 
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How to use the Ortho 
Batch Wizard 

To use this wizard, you must first setup the orthorectification parameters 
for each image using ER Mapper’s Geocoding Wizard.  When you get to 
the “Rectify” step, save the information you defined (click the ‘Save’ 
button), but do not perform the orthorectification at that time.  Instead, use 
this wizard to perform the final “rectify” step later as a batch process for 
all the images. 

Overriding 
parameters defined 
with the Geocoding 

Wizard 

When you setup the orthorectification parameters for each image using 
ER Mapper’s Geocoding Wizard, this information is stored in a header 
(ERS) file of each image.  This wizard gives you the option of using the 
resampling, cell size and null values defined for each image during ortho 
setup, or overriding them by selecting one common set of parameters.  
You might want to do this, for example, when you want to be sure that all 
output ortho images have exactly the same cell size.  (Be sure to select an 
output cell size that makes sense for your images, as unreasonable cell 
sizes can produce overly large output files or cause loss of image detail.) 

Output filenames When you define the ortho parameters for each image using ER Mapper’s 
Geocoding Wizard, you may also select an output filename at that time.  
However, the wizard cannot read this filename from the input files, so it 
assigns its own output filenames automatically.  These are either the same 
as the input filename (in which case you must choose a different output 
directory), or the input filename appended with a text string of your 
choice (in which case you may write to orthorectified files to same 
directory as the input files). 

 Print to PC Printer in Batch 
 

This wizard lets you print multiple algorithms in batch to any PC printer accessible 
from your computer.  This is a batch interface to the “PC Printing” option on the 
ER Mapper Print dialog.  This can be handy for batch printing map sheets overnight, 
printing multiple copies of the same image, or other purposes.  Options and features 
include: 

• Select the printer and print settings from within the wizard. 
• Select up to seven algorithms from any locations to print, or print all algorithms 

in a directory. 
• Print multiple copies of each algorithm. 
• Select a “timeout” wait period between prints to let the printer actually print the 

image before ER Mapper starts to process the next one. 
• Display each algorithm onscreen before printing it. 
• Pop-up status dialog to indicate progress of the print operations, including 

ER Mapper rendering and printer rendering stages for each algorithm and 
percent complete bar showing progress of the batch operation. 
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Note: This wizard cannot be used for Windows drivers that print to a file, only those 
that print directly to an attached printer.  The reason is that printing to a file requires 
assigning a unique filename to each output file, and this cannot be controlled directly 
from an ER Mapper wizard. 

Selecting printer and 
settings 

This option lets you select the PC printer to use, and any settings you wish 
to use for the subsequent print run.  To select the printer settings, click the 
Printer icon button in the wizard, then click Properties on the Print Setup 
dialog. 

Wait time between 
prints 

Just as in the standard ER Mapper printing, the printing is done in two 
stages: ER Mapper renders the algorithm into the printer format, then the 
printer prints the image.  The wizard has a “timeout” feature to let the 
printer actually complete printing the current image before ER Mapper 
starts to process the next one.  This may not be necessary for all printers, 
but was found to be helpful on those tested to avoid swapping the CPU 
between rendering and actual printing operations. (This lets the CPU 
devote full time to one or the other.) 

You should select the time it typically takes for your printer to actually 
print an image as your wait period setting.  If a wait period is not 
important for your printer, just select the minimum “1 minute” setting. 

Printing multiple 
copies 

The ‘Number of copies’ option lets you print multiple copies of each 
algorithm.  The choices are predefined to simplify, but range from one to 
10 copies.  Note that each “copy” is actually a separate print operation, 
and will take as long as a single print.  Therefore, multiple copies will not 
print faster than printing the same algorithm multiple times. 

In some cases, you may want to print three copies of one algorithm and 
one copy each of two others.  In these cases, it is easiest to use the “Select 
up to 7 individual files” option.  Set the number of copies to one.  Then 
load the first algorithm into three of the seven slots, and the others in one 
slot each.  (You are of course limited to seven total prints with this 
method.) 
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 Export Images in Batch 
 

This wizard lets you export a set of images to other common formats in batch.  
Output files get the same base filename as the input images (for example 
“photo1.alg” creates “photo1.tif”).  

Options and features include: 

• All images in a directory may be exported, all images listed in a text file, or all 
images loaded into a mosaic algorithm.  (The mosaic algorithm option lets you, 
for example, color balance the images and then export them back to individual 
images again.) 

• Supported input formats include ER Mapper Algorithm (.alg), ER Mapper Raster 
(.ers) and ECW Compressed (.ecw).  

 Note: Images in raster translated formats (such as TIFF, JPEG or BIL/HDR) can 
be exported by first creating ERS header files for them that contain the correct 
registration information, then selecting ERS as the input format. 

• Supported output formats include GeoTIFF (.tif), JPEG (.jpg), BIL with HDR (.bil 
and .hdr), ER Mapper Raster (.ers), ECW Compressed (.ecw) and ER Mapper 
Algorithm (.alg). 

• Images can be exported at the full resolution of each input image, or resampled 
to a common output resolution for all images.  (Resampling does not apply to 
algorithm (.alg) output since it does not create new image files.) 

• TIFF files can be exported to RGB, greyscale, 256-color or Multi Layer GeoTIFF 
or plain TIFF files (with 8- or 16-bit data format for Multi Layer). 

• Images with different coordinate systems (UTM, State Plane, Lat Long, etc.) can 
be processed in the same batch run if resampling is not selected.  (With 
resampling, images in meters/feet or decimal degrees can be processed, but not 
both.) 

• Output via an ER Mapper script, or a DOS BAT file that can be run now or at a 
later time. 
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Exporting images 
from a text file list 

You can specify the files to be exported by creating a text file listing the 
full path and filename of each file.  This allows the input files to be stored 
in different areas on your system.  An example text file might look like 
this: 

D:\Images_NW\image01.alg 
D:\Images_NW\image02.alg 
C:\Images_SW\image03.alg 
C:\Images_SW\image04.alg 

No other information or lines can be in the text file, only full path 
filenames (each line separated by a carriage return).  Input filenames 
should be unique because the output files will be written to a single 
directory.  The wizard will parse your text file and warn you if it can’t 
understand the format, or if some of the listed images don’t exist. 
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Exporting images 
from a mosaic 

algorithm 

The ‘All images in a mosaic algorithm’ export option lets you export all 
images in a mosaic with whatever processing has been applied to them.  
For example, color balanced versions of each image can be exported using 
this option.  This option exports the full extents of each image in the input 
mosaic algorithm, and only works for algorithms in Red Green Blue or 
Pseudocolor color modes (not HSI).  If RGB, the algorithm must be set up 
with the Red, Green and Blue layers for each image in that order.  If the 
algorithm has multiple surfaces, images in all surfaces are processed. 

You also have the option of whether to include or not include overlap 
from neighboring images in the mosaic.  If ‘Turn off all neighbor images’ is 
selected, then only the current image will be exported (which may include 
null or background color areas on the sides if the image is not 
rectangular).  If clip regions are used, null or background color will fill 
areas masked by the clip regions.  (This option is the equivalent of turning 
off all layers except those for the current image, zooming in to that image’s 
extents, then exporting the current view.)  If ‘Export images with overlap 
from neighbors’ is selected, then the full extents of each image are 
exported including any data from overlapping images in the mosaic. 

Output files are saved in the datum and projection selected for the input 
algorithm.  So if this is different than the projection of the input images (i.e., 
reprojected “on-the-fly” using the algorithm’s Coordinate System tab), 
then output files will be reprojected into the algorithm’s 
datum/projection.  This is an alternative way to reproject a set of images.   

Note:  You should not use “on-the-fly” reprojected algorithms that are reprojected 
to or from the GEODETIC projection or the output images may be invalid.  You 
can use “on-the-fly”reprojected algorithms between any meter- or foot-based 
projections. 

Tip:  With the ‘All images in a mosaic algorithm’ option, the input images in the 
mosaic algorithm can be in any format supported by ER Mapper.  For example, the 
input images in the mosaic can be in TIFF or JPEG format, not just ALG, ERS or 
ECW.   

Output file sizes Output TIFF files cannot exceed 2GB due to that limitation in the TIFF 
format specification.  (We recommend that you make TIFFs less than 
600MB as most software will have trouble reading very large TIFF.)  
Output file sizes for ERS, JPEG, ECW and BIL/HDR formats are generally 
unlimited, although certain system limitations may be encountered, or 
product limitations when trying to open them. 

Exporting from ECW 
to other formats 

ECW files can be very large when uncompressed, and can sometimes be 
too large to save to other formats such as TIFF.  You should check what the 
uncompressed file sizes would be before running the batch export.  
(Generally files less that 2GB uncompressed will work OK.)  If needed, 
you can tile large ECW files into smaller pieces using the “Cut Algorithm 
into Image Tiles” wizard. 
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Exporting at current 
resolution vs. 

resampling 

These two options allow a great deal of versatility to export images.  
Details on the two options and when to use them follow:  

Export each image at current resolution–Use this option when you want 
to export each image at the same resolution as the original data.  With this 
option, input images can be in a variety of projections if desired.  For 
example, algorithms in meter-based projections (like UTM), foot-based 
projections (like US State Plane) and the GEODETIC projection (degrees of 
Lat/Long) can all be exported in a single batch run.   

Note:  When using algorithm files as input, the default export resolution is 
determined by the highest resolution image in your algorithm.  So, if your 
algorithm contains images with 30-meter and 10-meter resolutions, the 
default output pixel size will be 10 meters. 

Resample all images to common pixel size–This option is available when 
exporting to ERS, ECW, TIFF, JPEG or BIL/HDR formats (not ALG).  Use 
it to export all images to a single, common resolution (pixel size) that you 
select.  For example, if you have a directory of images with slightly 
different pixel sizes, you can resample all the output images to a single 
common pixel size.  Or, if your input images have different X and Y pixel 
sizes, you can resample them to equal X and Y sizes so the images will 
display correctly on less sophisticated software.  (See ‘Unequal input cell 
sizes’ later.) 

One limitation when resampling is that images with GEODETIC 
projections and other projections cannot be processed in the same batch 
run.  (This is because a cell size specified in meters cannot be applied to 
resampling images in degrees, and vice versa.)  The cell size units from the 
first input image are displayed in the wizard.  When processing begins, 
any images with different cell size units will be automatically skipped.  
(Therefore, all input images should usually have a common map 
projection type when using the resampling option.) 

Page size ignored This wizard is not designed to create images at a particular “print size” or 
“page size” because these will typically alter the original data resolution.  
If using algorithms as input, page size settings (defined with Page Setup) 
are ignored when generating output files.  The image will be exported to 
display the full area at the resolution of the input images (unless you 
choose to resample the pixel size). 

Exporting images to 
algorithm format 

Exporting images to algorithm files lets you perform some basic image 
processing (such as contrast enhancements) on input images before 
exporting them to other formats.  You could, for example, apply a 99% 
contrast stretch to each image when creating the algorithms, then export 
the algorithms to TIFF or ECW to create contrast stretched versions of the 
input images.  Creating algorithms also lets you prepare images for 
multi-band output if desired (see “Exporting to multi-band images”). 
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Using TIFF, JPEG, and 
other formats as 

input 

The wizard is limited to ALG, ERS and ECW as input formats because it is 
important that georeferencing information be present in order to export 
the images correctly.  Many of the other formats ER Mapper supports do 
not always contain complete georeferencing information in the files (such 
as datum and projection) and it’s complicated for the wizard to try to 
check every file.  To use TIFF, JPEG, BIL/HDR or other raster translated 
formats as input, you have two options: 

• Create ERS header files for the TIFF, JPEG, etc. images that contain the correct 
georeferencing information.  (You can do this using the ‘Edit or Create ERS 
Files in Batch’ wizard.)  Then specify ERS as the input format when using this 
export wizard. 

• Create a mosaic of the images (if this makes sense for your images), then select 
the ‘All images in a mosaic algorithm’ option as the method for specifying the 
input file list.  This may be an easier option for GeoTIFFs that do contain 
georeferencing information so you don’t have to generate ERS headers.  
(Images in mosaic algorithms are assumed to be correctly georeferenced.) 

Exporting to 
multi-band images 

Each band in an input image can be exported to a multi-band output 
image by first creating an algorithm that places each band in its own 
algorithm layer.  The easiest way to do this is to run the wizard once and 
specify algorithm output with the “Layers for all bands” option, then run 
the wizard a second time to export the algorithms to the desired format.  
(This could, for example, be used to convert several multi-band ERS 
images to BIL/HDR or ECW formats.) 

Note that only ERS, ECW and BIL/HDR support large numbers of output 
bands.  TIFF supports up to four output bands, JPEG 1 or 3 bands. 

Exporting to 
greyscale images 

The TIFF, JPEG and ECW export formats have a “Greyscale” option that 
can be used to export single-band or greyscale input images to greyscale 
output, or to convert color input images to a greyscale representation.  The 
ERS and BIL/HDR formats do not store images as greyscale internally, 
and single-band input images should be output as “Multi Layer” to create 
equivalent single-band output files.   TIFF and JPEG do store greyscale 
internally in the files. 

Creating TIFF or JPEG 
World files 

The setting for adding creating World files for exported TIFF or JPEG images 
internal to ER Mapper.  To create World files for exported images, select 
Edit->Preferences in ER Mapper, click the General tab, then turn on the ‘Write 
world file on save’ option. 

Creating GeoTIFF files GeoTIFF information (tags) are added to the output TIFF files if either  'Add 
GeoTIFF information' is turned on in the wizard or in ER Mapper's File->Save 
As->TIFF->Options.  If you do not want GeoTIFF files, then 'Add GeoTIFF 
information' must be turned off in both places.  (If either is on you will get GeoTIFF 
files.) 
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TIFF LZW compression The wizard gives you the option of creating uncompressed or 
LZW-compressed TIFF files.  Some applications cannot read 
LZW-compressed TIFF files, or require a special license to read them.  
LZW is a “lossless” compression can reduce file sizes significantly 
depending on the amount of color variation in the images.  It works best 
on images that have large areas with a common color, such as 
classifications or scanned maps. 

ECW and JPEG 
compression ratios 

When exporting to ECW images, you select a target compression ratio.  
This is a target only, and the actual amount of compression will vary 
depending on the image qualities and amount of spatial variation.  
Recommended values are 1 to 40 for color images and 1 to 25 for 
greyscale. Higher values give more file size compression, lower values 
give better image quality. 

When exporting to JPEG images, you select a compression factor.  This 
determines the amount of file size compression versus image quality.  
Values between 1 and 100 may be entered.  Higher values give better 
image quality, lower values more file size compression. 

Resample type for 
common resolution 

output 

When you select the ‘Resample all images to common pixel size’ option, 
you also can select the type of interpolation technique used to resample 
output images to their new resolution.  The resample options are: 

Use bilinear interpolation–This option forces bilinear interpolation when 
resampling all output images.  (The same as turning on the ‘Smoothing’ 
option for all algorithms.)  When resampling to a smaller cell size than the 
original input images, bilinear interpolation creates a smoother, more 
visually pleasing image than nearest neighbor (so it is recommended). For 
resampling to larger cell sizes, the difference is negligible. 

Use nearest neighbor interpolation–This option forces nearest neighbor 
interpolation when resampling all output images.  (The same as turning 
off the ‘Smoothing’ option for all algorithms.)  When resampling to a 
smaller cell size than the original input images, nearest neighbor tends to 
create more jagged, “pixelated” output images then bilinear.  However 
nearest neighbor is recommended if retaining the original values as closely 
as possible is desired for output images (such as DEMs). 

Unequal input cell 
sizes 

If your input image has different X and Y cell sizes (for example 15 and 25 
meters), the output image is created to maintain this relationship (unless 
resampling is selected).  If your software product cannot handle images 
with different X and Y cell sizes (e.g., Photoshop, etc.), the images will 
appear stretched or compressed. 

You can use the ‘Resample all to common pixel size’ option in this wizard 
to set equal X and Y cell sizes to overcome this. 
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Rotation in TIFF and 
JPEG World files 

If your input images are rotated from north (i.e., the rotation value is not 
zero), the rotation values are written to the second and third fields in the 
output World files.  In addition, the cell sizes and registration coordinates 
may be adjusted to account for the rotation, as World files express this 
information differently than ER Mapper does internally.  The output 
images should open correctly in other software that can interpret rotation 
terms in World files (many do not). 

Conversion of World 
file cell sizes for foot-

based projections 

If your data is in units of feet, the wizard will convert the ER Mapper cell 
size (always internally in meters) to the correct values in feet in the World 
files created for TIFF and JPEG images.  This is performed for you 
automatically for input images whose projection units are feet.  This 
means the images will open and display properly in other software that 
allows cell sizes to be expressed in feet.   

In addition, the coordinate location of the upper-left pixel in the World file 
is adjusted to reference the center of the pixel as is standard for ESRI 
products.  This means that the coordinates in the World file will be slightly 
different than the upper-left coordinate viewed for the algorithm in 
ER Mapper‘s “Geoposition” dialog.  (ER Mapper references the upper-left 
corner of the upper-left pixel as the origin.) 

Output data types for 
ERS, BIL and TIFF 

exports 

When exporting to ERS, TIFF or BIL/HDR, you have options to select the 
data type (i.e., 8-bit versus 16-bit).  The data type option only pertains 
when exporting as Multi Layer.  (RGB, greyscale and 256-color TIFFs and 
RGB ERS and BIL/HDR files are always exported as unsigned 8-bit 
images.)  The output data type you select should normally be the same as 
the data type of the input images unless you want to recode the data 
ranges, or your processing algorithm produces a range of values that 
require a certain data type to store them. 

TIFF data types–Options are signed or unsigned 8- or 16-bit.  16-bit should 
be used when exporting images with 16-bit value ranges (i.e., 0-65767) that 
you want to retain (such as DEMs or 11-bit IKONOS images).  Use 
“signed” when the images contain negative values to retain them. 

BIL/HDR data types–Options are signed or unsigned 8-, 16- or 32-bit.  Use 
the appropriate type for the value range in your input images, and use 
“signed” when the images contain negative values to retain them. 

ERS data types–Options are the same as provided in the ER Mapper GUI.  
Use the appropriate type for the value range in your input images, and use 
“signed” when the images contain negative values to retain them.  Use the 
“real” options if your processing creates floating point numbers and you 
want to retain them in the output files. 
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 Edit or Create ERS Files in Batch 
 

This wizard lets you edit or create ER Mapper header (ERS) files as a batch process.  
There are five primary options explained following: 

• Change ERS file parameters–This lets you batch edit a directory of ERS files at 
once as an alternative to editing the files one at a time through ER Mapper’s 
Image Header Editor.  You can change the current datum, projection, null cell 
value or image rotation value.  You can also change the Units setting to Meters 
or Feet, and automatically convert cell sizes in feet to the their meter-equivalent 
values. 

• Restore previous ERS files–When you batch edit a directory of ERS files using 
the first option above, each ERS file is copied to a backup copy.  This option lets 
you restore the previous set of ERS files if results are not correct.  (Only the last 
saved version can be restored.) 

• Create ERS files for World file images–If you have TIFF, JPEG or BMP images 
that have associated World header files, this option automatically creates an 
ER Mapper ERS header for each image.  The wizard transfers the georeferencing 
information into an ERS header, so ER Mapper can display the fully 
georeferenced TIFF, JPEG or BMP images directly without having to import 
them.  Recognized World file extensions are .tfw for TIFF, .bpw for BMP, and 
.jgw, .jpw and .jpegw for JPEGs. 

• Create ERS files for TAB file images–If you have TIFF, JPEG or BMP files from 
MapInfo that have associated TAB (table) header files, this option automatically 
creates an ER Mapper ERS header for each TAB file.  The wizard transfers the 
georeferencing information into an ERS header, so ER Mapper can display and 
georeference the images directly without having to import them. 

• Create ERS files for GeoTIFF files–ER Mapper can read GeoTIFF files directly, 
so you usually don’t need to create ERS headers for them.  Reasons you might 
want to create them are so the GeoTIFF images can be exported to other formats 
using the ‘Export Images in Batch’ wizard, or to override the GeoTIFF 
information by editing the ERS headers. 

Notes:  ERS files cannot be edited if the ‘read only’ file attribute is turned on.  The 
wizard will automatically check the first file and warn you if this is the case.  Make 
sure all the ERS files in the directory to be edited have the ‘read only’ attribute 
turned off.  (Select Properties for the files and folder in Windows Explorer.) 
The wizard automatically skips editing any Virtual Images in the same directory (as 
these should not be edited, only the source ERS files they reference).  ERS files to be 
edited must not be ‘read only.’ 
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When to use this 
wizard 

This wizard can be useful when working with a large number of related 
images, such as a mosaic.  When you open or import the images, you may 
discover that you entered the wrong information, and would like to 
change all the ERS files as a batch process rather than editing them one at 
a time.  In addition, pixel (cell) sizes for images in foot-based projections 
my be interpreted as meters by ER Mapper.  This wizard lets you convert 
pixel sizes that are actually feet to their meter-equivalent values (since 
ER Mapper only understands pixel sizes in meters or degrees, not feet).  It 
is especially useful when working with images with World or TAB files 
because you can edit the needed information without having to import the 
files. 

Note: ER Mapper 6.2 and higher ships with a “Change 
Datum/Projection/Cell Size for many images” wizard (on the Batch 
Processing toolbar)  that can batch perform some of these changes as well. 

Testing the results of 
the batch editing 

It is highly recommended that you test the results of the batch editing 
immediately after each time you run the wizard.  (I.e., try mosaicking or 
otherwise displaying your images to see if the results are correct.)  This 
lets you revert back to the previous versions of the ERS files in case 
something went wrong or you made a mistake. 

Restoring original ERS 
files 

When you run this wizard, it creates a backup copy of each original ERS 
file with a “.bak” file extension.  So, if you batch-edited your files and 
made a mistake or don’t like the result, you can revert back to the original 
ERS files.  You do this by running the wizard again and selecting the 
“Restore original ERS files” option. 

Note:  The “Restore” option only reverts to the last saved version of the ERS 
files.  So, if you run this wizard three times and specify different changes 
each time, the Restore option will only restore the ERS files created after 
the third time you ran it. 

Projection 
information for World 

or TAB images 

When creating ERS files for image with World files or TAB files, it is 
important to know the datum and map projection of the images.  This 
information is not stored in the World files, and cannot be interpreted by 
the wizard from TAB files (although it is technically stored there).  If you 
are in doubt, contact the person who gave you the images to be sure. 

Note:  For U.S. State Plane projections, it is important to know whether the 
projection is in units of Feet or Meters.  If you select the wrong version, the 
georeferencing will not be correct. 

Rotation in World files If your input World file images are rotated from north (i.e., the rotation 
value is not zero), the rotation values are transferred to the ER Mapper 
ERS headers files as a single rotation value.  In addition, the cell sizes and 
registration coordinates may be adjusted to account for the rotation, as 
World files express this information differently than ER Mapper does 
internally.   
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 Cut Algorithm into Image Tiles 
 

This wizard lets you subset (or “cut”) a geocoded algorithm into tiles of standard 
geographic sizes (10 Km, 7.5 minutes, etc.), numbers of pixels (512 by 512, etc.), 
numbers of tiles (3 by 3, etc.) or reading names and extents from a text file.  This can 
be handy for subsetting a large image for output to another format, or creating a 
series of equal size images for map sheets.  Each tile is automatically saved as a 
separate image file or algorithm with a filename indicating its position within the 
whole.  When using geographic tiling,  tiles sizes must be specified in the same units 
as the map projection (meters, feet, or degrees).   

Options and features include: 

• Select from standard tile size lists, or enter your own custom X and Y sizes. 
• Use a text file containing the tile names and extents to help tile irregular areas or 

when specific tile filenames are needed. 
• Automatic naming conventions for algorithm tiles include row-column number, 

upper-left Easting/Northing coordinate, or tile number of the whole.  
(Easting/Northing coordinate option is not available for Geodetic images.) 

• Options to save tiles in GeoTIFF (.tif), JPEG (.jpg), BIL with HDR (.hdr), 
ER Mapper Algorithm (.alg), ER Mapper Raster (.ers), or ECW Compressed 
(.ecw) formats. 

• Specify adjacent tiles to adjoin exactly, or overlap by a fixed amount (for 
example 20 meters). 

• Automatically trims tiles in the last row or column to avoid creating tiles outside 
the extents of the input algorithm. 

• Display the number of tiles your selected tile sizes would create beforehand, so 
you can quickly see the effect of different tile sizes. 

• Output via an ER Mapper script, or a DOS BAT file that can be run now or at a 
later time. 

Note: This wizard does not accept “raw” algorithms (those that contain images that 
are not geocoded), or algorithms containing rotated images.  See “Cutting up “raw” 
images” following for information on possible workarounds. 
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Preparing the input 
algorithm for tiling 

To prepare your input algorithm for tiling, set the exact area you want to 
tile using ER Mapper’s View/Geoposition/Extents option.  This can be 
the entire extents of a large image or mosaic of images, or any subarea.  
The wizard does not allow you to define a starting point to begin tiling 
from because this is much easier and more efficient to do on the 
Geoposition dialog (where you can visually see the result to verify it). 

If you choose to cut the algorithm using “Geographic sizes,” be prepared 
to define the tile sizes in the same measurement units as your map 
projection.  For example, if you are using a UTM  projection in units of 
meters, you must specify tile sizes in meters also (not feet or degrees). 

Note:  It may not be possible to efficiently tile mosaic algorithms 
containing very large numbers of images (500 or more).  This is because 
the filesize of the input algorithm file (possibly several MB) makes it very 
slow to open, save and process for each tile.  The wizard will warn you if 
the input algorithm file size is over 2MB.  In these cases, we recommend 
that you export the area in several sections, then re-mosaic the sections 
and tile that algorithm.  You can also use Virtual Datasets to do this, but 
the processing time will be longer than if dividing into image files. 

Why save tiles in 
Algorithm format? 

Saving tiles in ER Mapper Algorithm (.alg) format does not actually create 
new image files.  This can be useful for several reasons, here are two: 

• Sometimes you need to tile areas with irregular coverage, such as a mosaic of 
images with areas of empty space.  After the wizard has created tiles for the 
entire area, you can delete ones that cover empty areas or optimize the extents 
of tiles along the edge by opening, adjusting and re-saving them.  You can then 
export all the ALG tiles to image files using the Export Images in Batch wizard. 

• You can generate a vector index map showing the tile layout before generating 
the actual images by mosaicking the algorithm tiles and then running the 
Create Mosaic Index Map wizard it.  This can help in determining which tiles 
can be deleted that cover empty or unneeded areas. 

Tiling “on the fly” 
reprojected 

algorithms 

With ER Mapper 6.4, algorithms can be reprojected “on the fly” to the 
screen to a projection different than the native projection of the images.  If 
you load one of these algorithms into the tiling wizard, it will export the 
tiles in the new projection.  This can be an alternative way to reproject 
images, but there are some important considerations: 

• Tiles cannot be cut properly from algorithms with the fly reprojection either to 
or from the GEODETIC (Lat Long) projection.  The wizard will try to flag this 
for you to prevent it, but may not always be able to so be aware.  You can use 
algorithms with on the fly reprojection between any meter- or foot-based 
projections. 

• It can take much longer (100% or more) to output the tiles if the algorithm is 
reprojected on the fly versus tiling an algorithm in the native projection of the 
input image(s) it contains.  This is due to the extra processing that has to be 
done to reproject the image data before writing it to a file. 
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How the tiling works The tiling wizard works by creating temporary algorithm files defining the 
extents for each tile in the output directory.  (If your output format is 
Algorithm, these are the final tiles.)  Each temporary tile algorithm is then 
used to export the area to a disk file such as TIFF or ECW, then deleted.  If 
you choose the ‘Run batch process with ER Mapper script’ option to 
export the tiles, each temporary algorithm is deleted immediately after it’s 
TIFF, ECW, etc. file is created.  If you choose the ‘Run batch process in 
background’ option, temporary algorithms for all the tiles are created up 
front in the output directory.  When you run the batch file, each one is 
then deleted after it’s tile image is created from it. 

Using a text file to 
define tile names 

and extents 

The ‘Text file with names & extents’ option for cutting tiles lets you define 
an exact set of areas to be exported.  This can be helpful for cutting up only 
sections of irregular mosaics that contain lots of empty space, or when a 
specific filenaming convention for tiles is required. 

The format for the text file is very specific.  It must contain the name of the 
tile followed by the minimum X, maximum X, minimum Y and maximum 
Y values separated by commas.  Each line must end with a carriage return, 
and the file cannot contain blank lines.  Decimal X and Y values are 
permitted.  Here is a simple example: 

tile01,200000,250000,3000000,3050000 
tile02,250000,300000,3050000,3100000 
tile03,300000,350000,3100000,3150000 

The name (first field) should not be a complete filename (i.e., 
C:\Temp\tile01.tif) because the wizard will create the full filename based 
on the output directory and file format you select.  It should be a text or 
number string with no spaces, commas, slashes or colons.  For example, if 
you select C:\Temp as the output directory and TIFF as the file type, the 
wizard will create the tile C:\Temp\tile01.tif during processing using the 
above example. 

Note: Tile extents must fall inside the input algorithm extents of incorrect 
results may occur. 

Creating “butt 
joined” tiles 

The term “butt joined” is used to describe tiles that meet exactly at the 
edges with no overlap.  Even with no (zero) overlap specified, you may 
still get one pixel overlap in some cases when using the “Geographic 
sizes” or “Number of tiles” options because the output files may have to 
be rounded to an integer number of pixels.  We recommend that you use 
the “Number of pixels” option to accomplish this using the procedure 
below. 

Note: If you plan to reproject the tile images later, you should always 
specify a small overlap.  Otherwise you may get some one-pixel wide gaps 
between the reprojected tiles due to resampling. 
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 1) Open your input algorithm.  If the algorithm contains more than one image 
(i.e., a mosaic), select one of the layers of the image in the upper-left corner. 

2) Using View->Geoposition->Extents, setup the extents of your input algorithm 
so that it starts and ends on an integer number of pixels that is evenly divisible 
by the number of pixels of your tile size.  For example, the following extents of 
8000 X and 4000 Y would work for 1000x1000 or 500x500 pixel tiles: 

3) Save your algorithm, and load it into the Cut Algorithm into Ti
Select to cut by “Number of pixels.”  When asked to select a tile
that is evenly divisible by the algorithm extents in pixels in step
tiles should butt join exactly with no overlap. 

Exporting tiles in 
“multi band” format 

When exporting to ERS, ECW, TIFF and BIL/HDR, you have the o
exporting the tiles as “multi band” image files.  This option is typic
used when you want to export all bands in a multi-band image, ra
than an enhanced image such as RGB.  Here are some general guid
for exporting as multi-band: 

• The input algorithm should be set up so that each band to be ou
with a unique label in the algorithm. 

• If you want to output the original values in your source algorith
select the ‘Delete output transforms’ option.  If ‘Delete output tr
selected, images will be exported with output value ranges scal
transforms in each layer. 

• If layers of the same type (Red, Pseudo, etc.) in your input algor
labels that match, those layers will be combined and output as a
layers of the same type (Red, Pseudo, etc.) have labels that do no
layers will be output as individual bands.   

Creating TIFF or JPEG 
World files 

The setting for adding creating World files for exported TIFF or JP
internal to ER Mapper.  To create World file for exported images, s
Edit->Preferences in ER Mapper, click the General tab, then turn
world file on save’ option. 
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Creating GeoTIFF files GeoTIFF information (tags) are added to the output TIFF files if either  'Add 
GeoTIFF information' is turned on in the wizard or in ER Mapper's File->Save 
As->TIFF->Options.  If you do not want GeoTIFF files, then 'Add GeoTIFF 
information' must be turned off in both places.  (If either is on you will get GeoTIFF 
files.) 

Specifying custom 
tile sizes 

The wizard allows custom tile sizes so you can specify a size not listed on 
the predefined menus, or use different X and Y sizes.  In addition, you 
may want to specify a size that corresponds to a different type of 
coordinate units.  (For example, if your algorithm is in a UTM/meters 
projection and you want to cut it into tiles 1 mile by 1 mile, convert one 
mile to its meter-equivalent value and enter that as the custom tile size.) 

Tile naming 
conventions 

Output algorithm tiles are named with either row/column, UL coordinate 
values, or tile number in sequence to indicate each tile’s position within 
the whole.  (Unless you select to cut tiles using names in a text file).  You 
can prepend a text string to the base tile name.  For example, if your select 
the row/column naming and the text string “Jakarta_,” the first tile 
created is could be named “Jakarta_r1c1.tif.”  If you choose to name 
output algorithm tiles with the row/column convention or tile number in 
sequence conventions, the first tile originates in the upper-left as shown in 
the following examples and the last tile is in the lower-right: 

 

 
row-column tile number 

Tile number naming 
option 

If you choose to name tiles by tile number, the tiles are created in sequence 
starting from the upper-left tile and finishing at the lower-right tile.  The 
number of digits in the tile names are automatically adjusted depending 
on the total number of tiles to be created.  If you are creating fewer than 
100 tiles, for example, tiles will be named 01.alg, 02.alg, and so on.  If you 
are creating more than 99 but fewer than 1000 tiles, tiles are named 
001.alg, 002.alg, and so on.  A maximum of 99,999 tiles may be created. 

When using this option, you can also specify the starting tile number (the 
number the wizard will assign to the first tile it creates).  For example, 
suppose you are tiling two large mosaics each into 200 tiles as separate 
processes (400 tiles total).  You might use a start number of 1 for the first 
set to create tiles named 001, 002 and so on to 200.  Then start the second 
set at 201 to create tiles named 201, 202 and so on to 400.  This avoids 
overlapping filenames.  (The start number is only used if you select the tile 
number naming option, otherwise it is not used by the wizard.) 
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Trimming of last row 
or column 

The wizard automatically trims the size of tiles in the last row or column if 
the tile extents would extend beyond the extents of the input algorithm.  
This feature avoids adding empty areas if no data exists there, and also 
honors the original extents of the input algorithm.  If you select to cut your 
algorithm into an exact number of tiles, or specify a tile size that divides 
equally into your algorithm extents size, no trimming is needed. In the 
example below, tiles in the last column and row have been trimmed to the 
extents of the input algorithm: 

 

 

Note: When exporting to ECW format, very small edge tiles may be too 
small to compress (files that would be < 100KB in size).  An error message 
window will appear if this happens, and you will have to validate the 
error dialog to continue the tiling process.  (The wizard cannot currently 
trap this error automatically.) 

Evaluating the tiling 
results 

Once you have subset your algorithm into tiles, you can easily evaluate the 
results by using ER Mapper’s Image Display and Mosaic Wizard to mosaic 
all your image tiles together into a single mosaic image again.  You can 
also load the individual tile algorithms one at a time and verify the size 
and extents using View/Geoposition/Extents. 

Tip: It can also be helpful to generate a mosaic index map of your tiles.  
Create a mosaic with the Image Wizard, save the algorithm, then run the 
Create Mosaic Index Map Wizard and load the mosaic algorithm as input. 
A vector index map will be created that shows the extent and filename of 
each algorithm tile. 

Creating tiles with 
overlap for 

reprojection 

If you have a set of images that adjoin exactly with no overlap, 
reprojecting them may cause a 1-pixel gap in some areas when the 
reprojected images are mosaicked.  One way to overcome this is to cut the 
original mosaic into tiles with a small overlap.  Then batch reproject the 
files with overlap.  (Only 2-3 pixels of overlap is needed.) 

Trimmed tiles for 
last row and 
column 
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Creating map sheets You can easily create individual map sheets from the tiles.  Define the 
desired Page Setup parameters for the first tile, and create a vector image 
with any standard map items you desire.  Once the first map sheet is done, 
you can quickly create the others using the Page Setup Wizard included 
with ER Mapper.  (The Page Setup Wizard lets you use the first map sheet 
as a template to create all the others with the same parameters.) 

Cutting up “raw” 
images 

The wizard cannot cut up “raw” images that have not been geocoded to a 
datum and map projection.  (The wizard checks this and informs you.)  
However, you can get around this if needed by modifying the image’s 
header (.ers) file information to enter false projection information.  To do 
this, open the image header editor (Load Image/Info/Edit).  Click Coord 
Space and enter a datum, projection and units (not “RAW”).  Click 
Raster Info and enter the X and Y cell sizes (the correct ones if you know 
them, other wise enter 1).  Then click Registration Point and enter false 
values in the Easting and Northing fields (for example 1000 and 1000).   

A registration coordinate (even a false one) is very important because the 
wizard uses this as the initial starting point and adds to and subtracts 
from it to calculate individual tile extents (so it can’t be zero).  Then save 
the changes, load your “false” geocoded image into an algorithm, and run 
it through the tiling wizard.  (Use the row/column naming convention 
since the coordinates are false and would not make sense.) 

 Create Mosaic Index Map 
 

This wizard lets you create an ER Mapper-format vector image showing the extents 
and image name of each image in a mosaic algorithm.  This can be useful to visually 
locate each image quickly by filename within the whole mosaic, or to create an index 
map for use in map composition.  The wizard creates a rectangular “index box” 
drawn to the exact corners of each image.  Options and features include: 

• Select the layer type in the algorithm for which index boxes will be created 
(Pseudo, Red, etc.). 

• Print or not print the image name inside each index box. 
• Assign a single color to all index boxes and text, or cycle through a set of 

rainbow colors (useful to assess boundaries of highly overlapping images). 
• Set index box line thickness, and image name font, size and position (either the 

upper-left corner or roughly centered in the index box). 
• For rainbow color index boxes, specify no fill, or stippled or diagonal line fill 

patterns for the index boxes. 
• Export the index map vector file to Shapefile and DXF formats. 
• Pop-up status dialog to indicate progress, including images found in the input 

algorithm. 
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Note: This wizard cannot operate on algorithms containing rotated images, and only 
images in the first surface of the algorithm are processed.  

Preparing an 
algorithm for index 

map creation 

Before running the wizard, you need to prepare an algorithm 
appropriately for index map creation.  Since only images in the first 
surface are processed, images in other surfaces will be skipped.  In 
addition, only images in a specific layer type are processed, and you can 
choose the type in the wizard. For example, if you have an RGB mosaic, 
you can choose Red, Green or Blue (or Intensity if used) as the layer type. 

You may want to create a specific algorithm solely for use in creating the 
index map.  This does not have to be enhanced in any way, it only has to 
contain the images you want to include in the index map.  You can use 
ER Mapper’s “Image Display and Mosaic Wizard” to do this if needed.  
Once the index map is created, you can display it on any other algorithm, 
for example a color balanced mosaic of all the images or an algorithm 
containing a Virtual Image mosaic. 

 As with all vector annotation in ER Mapper, it is desirable to setup a page 
size for your algorithm first before running this wizard.  (This is not 
essential, but recommended.)  The reason is that line thickness and text 
sizes are plotted relative to the algorithm page size.  For example, if you 
choose an 8x10 inch page size and select 12 point text in the wizard, the 12 
point text will appear in its correct size relative to the 8x10 inch algorithm 
page.  If you do not setup a page size, the text may appear very large or 
the lines very thick because it is not being displayed proportional to the 
point sizes you selected. 

Text size and position You must choose a text size that will allow the text to fit inside the index 
box, so some experimentation may be needed to get the best result.  Many 
different text size options are provided for different sizes and scales of 
maps.  If you have very long image names, you can use the upper-left 
corner text position option to allow more room.  The centered text position 
option does not center the text exactly within the box, only approximately.  
(Some slight shifting left or right is to be expected.  You can try a smaller 
text size, or edit the vector image and move the text strings if needed.) 

Exporting to 
Shapefile and DXF 

formats 

The wizard can automatically export the ERV vector image it creates to 
Shapefile and DXF formats.  The index boxes are encoded as polygons, so 
they can be reprojected if needed.  The following considerations apply: 

• Shapefiles will not contain the vector colors or text objects.  The image filename 
for each index box is stored as an attribute in the Shapefile named “Erv_attr.” 

• DXF files will contain the polygon objects and line colors, but text will 
not be transferred.  The image filename for each index box is stored as 
an attribute in the DXF named “Erv_attr.” 
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Converting the index 
boxes to regions 

Once you have created a vector index map, you can convert the index box 
rectangles to regions in a raster image.  For example, save the mosaic 
algorithm as a Virtual Image (VDS), then convert the index map to regions 
in the VDS.  This lets you perform “inregion” processing on specific image 
areas within the VDS, calculate separate statistics for each image area, and 
other possibilities.  To do this, use the Process/Polygon<->Region 
Conversion/Vector image polygons to Regions option on the main 
ER Mapper menu. (The image names are stored as text attributes for the 
index box vector objects, so they become the region names after 
conversion.) 

Using the index map 
in map composition 

To plot your index map as a map object, first generate the index map using 
the “single color” option.  Then display it in an algorithm and turn off any 
raster layers.  If you want a black index map on a white background, for 
example, set the page background to white (in Page Setup), and the vector 
layer color in the algorithm to black.  Save the algorithm, and plot it as a 
map object using the category “Algorithm” map object in annotation. 

 Create Rotated Clip Regions 
 

This wizard lets you create custom clip regions for a set of images in batch that mask 
out a specific percentage of the outer image area.  The regions can also be rotated to 
aid mosaicking of images acquired on oblique flight lines.  Features include: 

• Specify different X (horizontal) and Y (vertical) percentages for clipping. 
• Specify X and Y offsets to shift the region center to best fit images. 
• Rotate clip regions to help fit them better on image sets acquired with oblique 

flight lines (i.e., not directly north or south). 
• Preview the settings on any image, and adjust them as many times as needed to 

optimize the clip percentage and rotation. 
• Specify the region name to used for all images. 
• Automatically create a vector (ERV) index map showing the locations and 

overlap of all regions. 
• Each image filename is encoded as the text attribute of it’s corresponding 

polygon in the ERV index map vector file. 
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Why create rotated 
or percent clip 

regions? 

This wizard lets you create clip regions that may help you achieve better 
results when mosaicking and/or color balancing images.  For example, 
orthophoto images are sometimes acquired along oblique (non north-
south) flight lines.  So, although the images face north, they are rotated 
with large empty areas on the sides.  This wizard can help by creating 
regions that match the image rotation, and that can clip out outer areas 
containing fiducial marks or dark edges.  This can be useful even on 
images that are not rotated to create clip regions in batch with the same 
characteristics for all images. 

These regions can be used as an alternative to the ‘Image’ and ‘Image Clip’ 
regions created automatically by ER Mapper’s Image Balancing Wizard.  
(Sometimes these do not work well with rotated images.)  Creating custom 
regions can also be useful when working with compressed images (ECW, 
JPEG, etc.) whose outer empty areas do not contain a single “null” value 
that can used to mask empty areas when mosaicking. 

 
 

Original image mosaic With rotated clip regions applied 
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How do I use the clip 
regions? 

After creating the clip regions, you can use them with ER Mapper’s Image 
Display and Mosaic Wizard, and also the Image Balancing Wizard: 

• With the Image Display and Mosaic Wizard, select ‘Manually set mosaic 
method’ on the first page, then ‘Manually set mosaic properties’ on the next 
page.  One the next page, check the ‘Use stitch region for mosaic’ box and enter 
the name of the region (check spelling).  Your clip regions will be applied when 
the mosaic is created. 

• With the Image Balancing Wizard, select the ‘Balanced with clip regions’ 
option.  On the next page, check the ‘Use custom clip regions’ box and enter the 
name of the region (check spelling).  Your clip regions will be applied when the 
balanced mosaic is created. 

Notes: Misspelling the region name will cause the wizard to fail in both cases 
above, so be sure it is correct.  You can also apply the regions manually in the 
Algorithm dialog by loading the ‘Inside region polygon test’ formula from the 
Standard menu on the Formula Editor dialog, then selecting the region name. 

Using X and Y clip 
percentages 

The X and Y clip percentage settings let you specify the amount of the 
image interior areas to retain in the regions.  For example, a value of 80 for 
the X clip retains the interior 80% of the image, and clips out 10% on the 
left and right sides.   

  
Xclip = 80, Y clip = 80 Xclip = 70, Y clip = 70 

  
Xclip = 85, Y clip = 60 Xclip = 50, Y clip = 65 
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Using X and Y offset 
percentages 

The X and Y offset percentage settings let you shift the center point of the 
region in any direction.  Shifting the center point may help fit the regions 
better on images that have more image data on one side or another.  When 
rotation is applied, regions are rotated around the center point. 

X values move the clip region center left or right, Y values moves it up or 
down. Negative values (e.g., -10) move the X center left and the Y down. 
Positive values (e.g., 10) move the X center right and the Y up.  Setting 
both values to zero uses the true center point of the image. 

  
X offset = -10, Y offset = 0 X offset = 10, Y offset = 10 
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The clip region index 
map vector file 

When you select the option to create a vector file showing the region 
outlines, the wizard creates and ERV vector file with colored polygon for 
each region that was created.  This vector file can then be overlaid on top 
of the image mosaic to help evaluate where the regions occur and how 
much overlap they have. 

 

 
 

 Region index map on 
original mosaic 

Index map on region clipped 
mosaic 

 
Using the index map 

to get image 
filenames 

The vector index map file assigns the image filename as the text attribute 
for each polygon it creates.  This can sometimes be helpful to get the 
filename of a specific image in a mosaic: 

• Display the mosaic algorithm, then load the region index map in an 
Annotation/Map Composition layer. 

• Click the Annotation layer’s  button to open the Tools dialog. 

• Click the  button on the Tools dialog to open the Map Composition 
Attribute dialog. 

• Click the Select  button, then click on the polygon.  The image filename 
appears in the Map Composition Attribute dialog. 

Note: The order of polygon overlap in the vector file usually does not match the 
order of the images in the mosaic algorithm.  (This is because the wizard is 
operating on the order of files in the directory which may be different than a 
mosaic.)  To evaluate overlap, use the ‘Create Mosaic Index Map’ wizard with the 
mosaic algorithm.  It will create the index boxes in the same order (display 
priority) as images in the mosaic algorithm. 
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 Color Table Wizard 
 

This wizard lets you interactively create ER Mapper color tables.  You must restart 
ER Mapper after running the wizard so it recognizes your new color tables.  Features 
include: 

• Select up to seven colors graphically using the standard ER Mapper color 
chooser buttons, or type in RGB values or color names. 

• Create smoothly interpolated or stepped color tables. 
• Specify the color table filename and description. 
• Automatically saves the new color table in ER Mapper's color table directory 

(/lut). 

Creating color tables This wizard is a graphical interface to the “makelut” command line 
program included with ER Mapper.  (However, makelut does not let you 
create stepped color tables as this wizard does.)  You can create color 
tables with from two to seven different colors.  The wizard interpolates 
between the colors you choose to create a color table with smooth or 
stepped transitions. 

It is recommended that you use fairly short filenames when creating your 
color tables because this is the name that will appear under the Color 
Table list in ER Mapper.  You can easily experiment and quickly create 
several color tables, then delete the ones you don’t like after restarting and 
viewing them ER Mapper.  (To remove unwanted color tables, delete the 
files with “.lut” extensions in the ER Mapper’s /lut subdirectory.)   

Using new color 
tables 

After creating new color tables with this wizard, you must close and 
re-start ER Mapper in order to use them.  (ER Mapper reads the color table 
list upon startup, so new ones added while the software is running will 
not show up in the list.) 

Default color table When you close ER Mapper, it remembers the last color table selected.  If 
you then delete this color table and restart, ER Mapper will complain that 
it cannot find the color table.  Simply select a different color table, close a 
restart ER Mapper to correct this. 
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Smooth versus 
stepped color tables 

Smooth color tables have a gradual transition between the colors you select 
in the wizard.  The wizard uses ER Mapper’s “makelut” program to create 
the color table, so the results are identical. 

Stepped color tables have blocks of discrete color, and can have 4, 8, 16 or 
32 “steps” of color.  The stepped color table is created to include the top 
and bottom colors you select in the wizard as the first and last steps, and 
intermediate colors are created by evenly stepping through the remaining 
transitional colors in between.  Stepped color tables are commonly used 
for topographic and contour maps, and are useful as an alternative to 
ER Mapper’s “level slice” transform. 

 Run Algorithm Slideshow 
 

This wizard lets you display all algorithms in a directory one after another, so you 
can create your own “slideshow.”  This is handy for self-running demos at 
tradeshows, or easily cycling through a series of algorithms during a presentation.  
Options and features include: 

• Automatic (unattended) or manual control 
• Number of cycles to run, time between images and image window size (for 

automatic control) 
• Start, move ahead or move back one slide (algorithm) for manual control. 
• Automatically shapes each image window to fit the current algorithm shape, and 

lets you select the maximum allowable window size. 
• Preferences to remember the algorithm directory and other settings from the last 

time the wizard was run. 
• Pop-up status dialog to indicate slideshow progress, including start of new cycle 

(for Automatic control) and current algorithm name. 
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Auto vs. manual 
control 

Automatic control lets you run the slideshow unattended, and it ends 
when the number of cycles through the algorithms has been completed.  
This is typically used for self-running demonstrations.  You can kill the 
slideshow early by closing the image window, but an error message will 
appear when the next algorithm tries to load into a non-existent window.  
You can resize the image window at any time and it will be used for all 
other algorithms. 

Manual control lets you cycle through the algorithms, advance or back up 
at your direction.  This is typically used for presentations.  Be sure to wait 
until the current algorithm finishes displaying before clicking the “Next 
slide>>” or “<<Previous slide” buttons.  (They do not take effect until the 
current algorithm completes.)  You can resize the image window at any 
time and it will be used for all other algorithms. 

Note: Do not switch between auto and manual control in the same session.  
Instead, close the wizard and restart it. 

Algorithm display 
order 

Algorithms are displayed in alphabetical order, or as they appear in a 
directory listing.  One way to specify an exact order is to name them with 
filenames starting with 2-digit numbers.  For example: 

01_1985_image.alg 
02_1992_image.alg 
03_1999_image.alg 

• 
• 
• 

12_1992_1999_change.alg 
Maximum image 

window size 
The wizard automatically resizes the image window to fit the shape of the 
algorithm as each one is displayed.  You can specify the maximum image 
window size (in screen pixels) that you wish to use, so you can tailor the 
image displays to a particular monitor or screen size.  If you specify a 
maximum of 600, for example, windows will never be taller or wider than 
600 pixels. 

Time between 
images setting 

When using automatic control, the “Time between images” setting 
controls the amount of time the wizard waits before loading the next 
algorithm.  This time does not include the time it takes for raster or vector 
processing or 3D rendering.  (That is, the time period starts after 
processing completes.) 

However, time to render terrain detail levels for 3D algorithms is included.  
This means that using low time settings (such as 5 seconds), some 3D 
algorithms with high terrain detail settings may not finish fully rendering 
detail before the next algorithm starts loading.  If this happens, use a 
larger setting for “Time between images” to let detail levels fully render 
(or reduce the terrain detail setting for the algorithm). 
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Troubleshooting 
 

This section provides information on troubleshooting and reporting problems. 

Common mistakes, questions, and tips 
This section lists common mistakes that new users especially may encounter when 
running the wizards, and tips on how they actually work that may be helpful.  Please 
look through this list thoroughly before reporting problems. 

Preparing directories 
of files for input to the 

wizards 

Several of the wizards read a directory of files and perform operations on 
them (import, rectification, etc.).  Since the wizard is designed to run 
unattended in batch, it is very important to make sure that all files in the 
input directory are set up correctly so they can be run through the wizard 
without problems.   

For example, if you want to rectify all images in a directory, be sure ahead 
of time that they all have GCPs selected and the appropriate number for 
the polynomial order you plan to select in the wizard.  Also, be sure that 
you have write access to output directories, and enough disk space to store 
all the output files. 

Specifying input or 
output directories 

Several of the wizards require you to specify input and/or output 
directory locations.   

• In most cases, the wizards determine the input directory by asking you to select 
one file that directory, then get the directory path from that file.  (The “Export 
Images in Batch” wizard will ask for an input directory directly.) 

• For output, you to choose a directory directly by clicking the file 
chooser button, clicking once on the desired directory folder, and then 
clicking the ‘Select’ button.  (Typing directory paths manually is not 
recommended because of syntax errors.) 

For output files directories, the wizards usually set the input directory as 
the default output directory.  You can change this as desired, and in some 
cases you will be asked to change it.  Be sure you have write permissions to 
the output directory or the wizard cannot write files to it.  Also, be sure your 
output directory is not referencing a CD-ROM or other non-writable drive. 

File not found errors Error messages indicating that no files were found are usually due to 
incorrect directory specification or directory does not have read access.  

Could not open file 
errors 

Errors indicating that an output file could not be opened are usually due 
to one of two things: 

• Incorrect directory specification. 
• You do not have write permission to the output directory you specified. 
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Maximum number of 
files in a directory 

Wizards that are designed to read a list of files from a directory have been 
tested with up 1500 files in a directory.  Although the wizards are 
designed to read an unlimited number, there may be a limit encountered 
at the system level.  If this happens, split your files into groups 
(directories) of fewer files and run the wizard again. 

Import wizard may 
“hang” on invalid 

files 

The “Import Images in Batch” wizard will attempt to skip over an invalid 
file if possible and move on to try the next one.  However, this is not 
always possible, and the wizard may “hang” sometimes if an invalid file is 
encountered.  (This is especially known for invalid TIFF files.)  If this 
happens, you may need close and restart ER Mapper to kill the process.   

If a file does not import, try opening or importing it with the standard 
ER Mapper interface.  If it does open or import there, report the problem 
(see the “Reporting Problems” section).  If it does not import, you need to 
open the file in a graphics editor and resave it in a format supported by 
ER Mapper. 

GeoTIFF datum or 
projection not 

matched 

When importing GeoTIFF files, the datum, projection and other 
georeferencing information is encoded automatically in the output 
ER Mapper image during the import.  However, if the projection in the 
GeoTIFF file has no direct match in ER Mapper’s projection database, the 
georeferencing information may not be set automatically and defaults are 
used.  You can see the datum and projection assigned by opening the 
GeoTIFF file using File->Open in ER Mapper.  

Imported TIFF or JPEG 
with World files don't 

mosaic correctly 

When importing TIFF or JPEG with World files, or creating ERS headers 
for them, you must specify the datum and projection of the TIFF or JPEG 
images. This is needed because the World file format does not contain this 
information, but ER Mapper needs it to properly register each image.   

If the images are not properly registered after import or header creation, the usual 
reason is that you selected the wrong datum or map projection for the images.  If 
you do not have this information, contact the person who gave you the TIFF or 
JPEG files and have them get this information.  If your data is in a US State Plane 
projection, be sure you select the correct ER Mapper projection for feet or meter 
versions of those projections. 

World files or GeoTIFF 
Info not generated 

for TIFFs or JPEGs 

The setting for adding creating World files for exported TIFF or JPEG images 
internal to ER Mapper.  To create World file for exported images, select 
Edit->Preferences in ER Mapper, click the General tab, then turn on the ‘Write 
world file on save’ option. 

GeoTIFF information (tags) are added to the output TIFF files if either  'Add 
GeoTIFF information' is turned on in the wizard or in ER Mapper's File->Save 
As->TIFF->Options.  If you do not want GeoTIFF files, then 'Add GeoTIFF 
information' must be turned off in both places.  (If either is on you will get GeoTIFF 
files.)  
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Stretched or 
compressed TIFF files 

If your input ER Mapper images have different X and Y cell sizes and you 
export these to TIFF or JPEG images, these images may appear stretched 
or compressed when viewed in products that do not understand 
georeferencing (e.g., Photoshop, etc.)  This is not a bug, but a limitation 
due to the inability of those products to understand the concept 
georeferencing and different X and Y pixel sizes.   

If you have images with different X and Y cell sizes and want to output a 
“universal” TIFF file that will display correctly in any product, you can 
resample them to a common X and Y cell size by selecting to resample the 
cell size when exporting the images.  (The ‘Export Images in Batch’ and 
‘Cut Algorithm into Image Tiles’ wizards both provide this option.) 

Very large or small 
rectified, resampled 

or rotated files 

When rectifying, rotating, or resampling images, you may create very large or very 
small output files if you specify an output cell size that is not appropriate for your 
images. For example, if you are rectifying a 30-meter Landsat image and specify an 
output cell size of 10 meters, the output file will be nine times larger than the input 
file.  Conversely, a 100-meter cell size would create a very small output file with 
much loss of resolution and image detail.  Be sure you research and determine an 
appropriate cell size before running these wizards. 

Empty space on 
sides of rotated 

images 

Rotating images may create output images with extra empty (null) areas 
around the actual image data.  This is a byproduct of the rotation process 
and cannot be avoided.  It may be desirable to cut the empty areas out 
after doing the rotations by zooming in to data area and saving as a new 
image file. 

Killing wizards Once a wizard has begun batch processing at the system level, it may be 
difficult to stop or “kill” it.  You can try by selecting View/Batch Engine 
Script Control, then clicking the Cancel Script button.  This may not take 
effect immediately, but will typically work to kill the batch process after 
the current operation is completed (for example the current file being 
imported).  As a last resort, you can kill the ER Mapper process 
(“g_ermapper.exe”) at the system level and all batch script operations will 
also be closed down. 

PC print wizard 
problems 

If your algorithms begin the rendering stage before the current one has 
finished printing on your printer, your system may run slowly because the 
CPU is swapping between two operations at once.  (Trying to print one 
image while rendering another.)  If this happens, increase the timeout 
setting so your printer has time to complete the print before the next 
algorithm begins rendering. 

As with printing directly from ER Mapper, you must have sufficient disk 
space to store temporary Postscript files that are created by ER Mapper 
when rendering vector layers in your algorithm.  If you do not have 
sufficient disk space for this, printing may halt. 

The PC Print wizard cannot be used to print to files, i.e., you cannot use 
Windows printer drivers that print to files instead of attached printers.  
The reason is that an individual filename would need to be assigned to 
each output file during the batch print run, and this cannot be controlled 
directly from within ER Mapper batch scripts.  You will have to manually 
print each algorithm to a file instead. 
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Reporting problems 
Earthstar Geographics provides basic support via email for these ER Mapper 
wizards.  (Please do not contact Earth Resource Mapping or their resellers for 
support.)  However, it is very important that you use all the resources provided here 
before emailing us with your problem.  If you have a problem, please follow this 
procedure: 

1) Thoroughly read all the documentation provided with the wizards.  Support will 
not be provided to those who unlawfully copied the software, and you may be asked to 
provide proof of purchase if you are not the purchaser of record.  Please do not send 
questions that you can answer yourself with a few minutes of investigation.  (That 
is why this user guide and wizard online help are provided-please use them!) 

2) Try the same operation (if applicable) through the standard ER Mapper interface.  
For example if a file does not import or a image does not rectify, try doing that as 
you normally would in the ER Mapper interface.  If the file fails there as well, it 
is not a problem with the wizard, but a problem with your data or limitation 
inherent in ER Mapper.  

Note:  If applicable, open the log file created by the wizard and read any error 
messages.  When possible, system messages are written to the log file and this 
may provide clues as to why the process failed. 

3) After you have tried 1 and 2 above, email your problem to this address: 

 esgwizards@es-geo.com 

 Be sure to specify the following information in your message: 

• Your name, company, telephone number and email address.   
• Operating system (Win95 or 98, or WinNT/2000 or XP). 
• Wizard exhibiting the problem. 
• Input to the wizard and output you expected to achieve. 
• Copy of the log file created by the wizard (if applicable). 
• Complete description of the problem with as much detail as possible, including 

all options you selected in the wizard and any error messages.  Please avoid simple 
descriptions like “it doesn’t work.”  Questions cannot be answered unless 
you clearly define the problem the first time. 

All attempts will be made to answer support queries in a timely manner, however it 
may sometimes require 3-5 working days for a response due to vacations and travel. 
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Enhancement requests 
Feel free to email any enhancement requests to us, or requests for new wizards you 
would find useful.  We will log these and evaluate them for inclusion in future 
releases of the wizards.  (We also perform custom wizard development to your 
specifications if desired.) 

Please send email about enhancements to the following address with the title 
“wizard enhancement request.” 

 esgwizards@es-geo.com 
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